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To get started using your iBook, plug in the power adapter and connect a phone cord from a wall
jack to the modem port. Then press the power button and follow the onscreen guide to connect
to the Internet. Read on to learn more about using your iBook:

10
12
14
16
18
20
22

2 Your iBook at a glance
4 Mac OS X basics
8 What you can do with your iBook

Listen to music on your computer or on the go
Make your own movie or watch a movie on DVD
Search the Internet

Get more out of the Internet

Send and receive email

Organize, plan, and create

Keep your iBook’s software up-to-date

24 Learn more and solve problems

30 Install memory and an AirPort Card
34 Work more comfortably

36 Safety and cleaning
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Your iBook at a glance

Your computer has these built-in features:

Volume and

brightness controls
Adjust sound volume and
screen brightness.

Two built-in

stereo speakers
Listen to music, movies,
games, and multimedia.

Optional AirPort
wireless Internet

and networking
(underneath keyboard)
Using the optional
AirPort Card, you can
connect to the Internet,
use email, share files,
play network games, and
more—without any
wires to hold you down.

Sleep indicator light
Pulsating light indicates
that the computer

is in sleep.

[y
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Built-in microphone
Record sound or control
your computer with
spoken commands.

- (1) Power button

Turn your computer on,
put it to sleep, or shut it
down.

- 2 Media Eject (F12) key

Press and hold to eject
a CD or DVD or to open
the optical drive tray.

== Power adapter
connector

Plug in the power adapter
(included) to recharge your
iBook’s battery.

Optical disc drive
Install and run software
or listen to music CDs.
Play DVD videos if you
have the DVD/CD-RW
or Combo drive, or
create your own CDs if
you have the CD-RW or
combo drive.



Kensington
security slot
Attach a lock and cable
to prevent theft.

Modem
Connect to the Internet,
browse the World Wide
Web, and send and
receive electronic mail.

Ethernet
Share files with another
computer or access a
computer network.

FireWire
Connect a digital video
camera and use it to
create your own desktop
movies. You can also
connect FireWire hard
disks, printers, and more.

UsSB
Connect printers, Zip
and other disk drives,
digital cameras, joysticks,
and more.

VGA port
Connect an external
monitor (using the
included Apple VGA
Display Adapter).

Reset button
Use during
troubleshooting to restart
your computer.

Audio/video port
Connect headphones or
external speakers.
Connect a TV or video
projector using the
optional Apple AV cable.

Battery level indicator
(underneath) When you
press the button on the
battery, one to four lights
glow to show how much
charge is left.

To learn more about your iBook’s features:
= Choose Mac Help from the Help menu.
Then click Go under “iBook at a glance.”
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Mac OS X basics

The Macintosh desktop is your starting place.

Apple menu

Use to change

system settings, open
recent items, and restart
or shut down your
computer. To see the
menu, click the apple
(@) in the menu bar.

Window buttons

Click the red button to
close the window, the
yellow one to minimize it
into the Dock, and the
green one to resize it.

View buttons

Click to see your
files as icons, in lists,
or in columns.

(-BC3 Finder

File

About This Mac
Get Mac OS X Software. ..

System Preferences...
Dock
Location

Recent Items
Force Quit...

Sleep
Restart
Shut Down

Log Out...

Edit View Go Window Help

4 tclark3

& ) 11:23 AM

-, Y e A

Computer Home Favorites Applications

Desktop

Movies

.......... Public

Finder icon
Click to open a
Finder window so

you can see the files

and applications on
your computer.
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Documents

&

Pictures

To learn more about Mac OS X:

Er

Macintosh HD

= See the Welcome to Mac OS X document in the

Documents folder on your hard disk.

Modem status
Use this menu

to connect to and
disconnect from
the Internet using
a dialup modem.

Toolbar button
Click to show or hide
the toolbar.

Toolbar icons

Click to navigate quickly
to different folders.
Your home folder
contains your personal
documents.

Trash

Drag an item here to
delete it. ltems remain
here until you choose
Empty Trash from the
Finder menu.



G008 File Edit View Go Window Help ) 11:23 AM

+ About the Finder

Preferences... Er
GXE -

Application menu
Shows the name of the
application you’re using.

Empty Trash
Use to set preferences Macintosh HD
it applications 0 B
or qui
' Hide Finder ®H ‘a0
(other than the Finder). e % D|§c
Show All Audio €D This appears when a CD

or DVD is in the disc drive.
Double-click the icon to
see what’s on the disc.
- A_‘\ v 7 A To eject a disc, press and

Computer Home Favorites  Applications

Application =
Applications are software
programs (such as a

|4 Applications

game or word processor)
that you use with your
computer. Double-click
an application’s icon to
open the application.

Document

Documents are files that
you create with an
application (such as a
letter you create with your
word processor). Double-
click the icon to open the
file in the application used
to create it.

Calculator Clock

ﬁ | Documents
iMovie |!:| ﬁ w #

Computer Home Favorites Applications

Bassoon Insects

=N
s | =L
Berceuse.mp3 Poetry

Dock
Click icons in the Dock
to open applications,
documents, folders,
or minimized windows.
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hold the Media Eject (&)
key on the keyboard.

-~ Folder
Folders help organize
your files and
applications. Double-
click a folder to
see what’s inside.



Change the Mac OS to suit your preferences.

There are lots of ways to customize Mac OS X.

@ Finder

File

To change Finder =

Edit View Go Window Help

settings, choose

[CRORY

Finder Preferences

Preferences from the
Finder menu.

Show these items on the Desktop:
™ Hard disks
_\fRemovable media (such as CDs)
W Connected servers

New Finder Window shows:

System Preferences

& ) 11:23 AM

,
*

= =)
Choose System n.‘ (a @ .
Preferences from Show All o.sm;v; Sound Network Startup Disk
the Apple menu to personal

change most of your
computer’s settings.

Desktop

Dock General  International Login

| Hardware

eoce

- B e B @

Screen Saver

Universal
Access

i} telark3

0

- P

ColarSync Displays  Energy Sav| @ E =1 5
Back View
To select a desktop =« Internet & Network
background picture, open @ @
System Preferences and e

click Desktop.

System

Classic

o
G
Date & Time

Download from Www.Somanuals.com
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i Computer Home Favorites Applications

[0 HBE D

r=
-

To change the size of
the Dock or move it to
a different place, open
System Preferences
and click Dock.

* To change icon sizes
or the background of a
Finder window, choose
Show View Options from
the View menu.
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Click the icons in the Dock or toolbar to find and open files and applications.

Finder File Edit View Go Window Help ) 11:23 AM

files, and folders
into the Dock for
one-click access.

|+ Applications [=]

m Y e A b

! Computer Home Favorites Applications Movies Music :
| Applications »  [Z} Acrobat Reader 5.0

MICTTESHD

-+ To set up the toolbar the
way you want it, choose

- - = " [ Ubrary A Address Book Customize Toolbar from
B gz""'"“ 5 g:"":eff'i‘ . ¥ the Finder’s View menu,
L sers » ppleWorks [ 3 .
| ® CaI:uIamr then drag items to
& Chess the toolbar.
() Clock
Image Capture |
£ iMovie

¥/ Internet Connect
£ Internet Explorer

** Press a folder icon to
see its contents and open
items in it.

4 Bassoon
| Berceuse.mp3
2 Book report

| Insects >
4 Poetry
Show In Finder

This side of the Dock -
shows application icons.

: : This side of the Dock
* The triangle indicates the shows files, windows,
application is open. * Drag this bar up or down to and folders.

resize the Dock.
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What you can do with your iBook

Not sure how to get the most out of your new iBook? Read on for a few ideas.

Make your own CDs. Use iTunes @ to transfer music from your CD collection. If your iBook
has a CD-RW or Combo drive, burn your own music CDs. Transfer music to an iPod or other MP3
player to listen on the go. Make a movie. Shoot video on a DV camcorder and import it into
iMovie ﬁ Then rearrange, edit, polish, and add titles and soundtracks. Connect to the
Internet to send email and browse the Web, or use iTools @ to post digital photos to the Web

for everyone to see.

Browse through the next few pages to find out more.
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The iBook is your
digital hub.

Send digital photos to Se. '
friends and family. e = et Import and edit
J homemade movies.

" - ge Capture _File Edit View Window Help & 1) 11:23 AM

B _=na

Ok ComputerHome _Favories_ Applcations
B Address Book 1 Movie
13 Applescript »| % iMovie Read Me (eb). -
 Galculator [ Resources B 'S VN

— 4 & : Name: iMovie
Kind: Application |
size: 7.7 M8

Image Capture \

(T Y 2 -
w Pictures, Movies, and Music folders X b ((.f
Automatic Task: WE

[Format 4x6 "

Send email and surf . - =
ko s [ o AR
the 'Net. | -

e e Put 1,000 songs in
‘ your pocket.

Listen to music and

¢ — — = B : I burn your own CDs.

Watch DVD movies. B
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Listen to music on your computer or on the go.

Use iTunes to create a library of music and make your own CDs.

@ iTunes File Edit Controls Visuals Advanced Window Help ¢ o) 11:23 AM Burn CDs

Library

Your collection of
songs, imported from
your own audio CDs or
downloaded from the
Internet. Easily browse
or search for music.

Radio Tuner

Choose from hundreds
of Internet radio
stations — jazz, rock,
talk, and more.

Audio CDs

Play an audio CD on your
computer. Import songs
to your Library to play
them without the CD.

iTunes

Radio Tuner
(20 Audio €D

o| & Classical

{ Dance

gﬁ

Macintosh HD

Q

Audio CD

If your iBook has a
CD-RW or Combo drive,
make your own audio
CDs that play in standard
CD players.

Playlists

Make personalized
playlists using songs
from your Library.
Arrange your music by
mood, artist, genre, or
however you like.

Equalizer

Adjust the sound to
your tastes using
the 10-band EQ with
22 presets.

To learn more about iTunes:
= See iTunes Help, available in the Help menu.
= Go to www.apple.com/itunes

10
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If you have an iPod, you can transfer up to 1,000 songs.

Connect iPod using the FireWire cable included with iPod. \
1. iTunes automatically transfers your music Library to iPod. oty

Unplug
2 . iPod.

Browse for a song on iPod and
5. press the Play button.

To learn more about iPod:
= Open iTunes and choose iPod Help from the Help menu.
= Go to www.apple.com/ipod

Download from Www.Somanuals.com. All Manuals Search And Download.
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Make your own movie or watch a movie on DVD.

Use iMovie to edit video from a digital video camera.

File Edit

IMOVIE

Advanced Help ¢ W) 11:23 AM

} Shoot video - ' } You can export
with a digital video 2 N ¢ your finished
camera. Then movie to a

connect the
camera using a

tape in your DV
camera or to a

Clip 03

10:15

6-pin to 4-pin QuickTime file.
FireWire cable and ot N =5 H
import your clips. Clip 04 Clip 05  Clip 06

- Shelf

Clips appear here when
you import them. Move
clips to the viewer

to make them part of

iMovie monitor *--*
Preview your movie or
view video from a
connected DV camera.

your movie.
=
lips | Transitions | Titles | Effects | Audio sdesoes Editing buttons
Free Space: 12.66CB [’::"] — C“Fk t.o open panelg for
................................. o | adjusting and selecting

Viewers -

Click the clip viewer

(eye tab) to edit and
place clips. Click the
timeline viewer (clock tab)

Clip Selection: Clip 06 Time: 03:04

~ | sounds, video effects,

titles, and transitions.

to edit sound. ———
Playback controls * To learn more about iMovie:
Use these to play the movie in the = Open iMovie and choose iMovie Help from the
iMovie monitor. Click the Play Full Help menu.
Screen button to use the = Go to www.apple.com/store to find compatible
entire screen. DV cameras or to purchase a FireWire cable.

12
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If your computer has a DVD drive or Combo drive, you can watch DVD movies.

To learn more about DVD Player:
= Choose DVD Player Help from the Help menu.

& DVDPlayer (ilc (it Videa Controls Window Help ¢ 4 11:23 AM

Viewer

\:/\!z \h_‘/*:d/ '_4 foeer) i e F]

1 Insert a DVD video disc. DVD Player 2 Use the controller to play the movie

opens automatically. or see the DVD’s special features.

13
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é Explorer File Edit View Go Favorites Tools Window Help & ) 11:23 AM

Search the - ——

Back Forward Stop Refresh  Home - AutoFill Print

Internet. i

If you know the Internet _ Thd?gﬁg}tﬁfre?fy’fg .
address, you can go é T e
there directly.

Create DVDs.

P> If you have a dialup connection, you can use
the modem status icon (&) to connect to and
disconnect from the Internet.

Take Pictures. Watch DVDs.

| Emmmpem 8 4 “n

Surf the Internet. Burn CDs.

& Internet zone

To learn more about Internet Explorer:
= Open Internet Explorer and choose
Internet Explorer Help from the Help menu.

Click the icon in the Dock to open Type the Internet address and press
1. Internet Explorer. 2 . Return on your keyboard.

14
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Or you can search the Internet
with Sherlock.

P> Click the other buttons to find people, read the
: news, shop, and more.

P> Click the hard disk icon to search the files on
your computer.

Sherlock File

Edit Find  Channels Help

Sherlock

eece e

BONOEK

" \why Is the sky blue?

&P Ask Jeeves
B sest site First
@ oner

& excite

@ Headhunter.net

IDRANDODRARAS

— [ Why is the sky blue?

806 Sherlock

& o) 11:23 AM

=29aé¢ LEmy K

@ | why is the sky hlue? | @

—_—

Name ;m___ vanc
Uy www.why-is...sky-blue.org
iy

‘ Why is the sky Blue?

math.ucr.edu

‘ Blue Sky - Why is the Sky Blue? i www.scienc.. desimple.com

[®] ART-Why Is the Sky Blue? [y
n Why is the sky blu.__ s the sunset red? (I
Why is the sky blue? I
Why s the sky blue - guiz list L

floodplain.org
weather.about.com
www.compendium.org
www.why-is...sky-blue.org

Items Found: 90

Macintash HD

Click the icon in the Dock to 3 Click the Search button (Q). Then

open Sherlock.

double-click an item in
the list of sites.

Click the Internet icon and type
a question in the search field.
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Get more out of the Internet with 1Tools.

iTools is a suite of Internet services integrated into Mac OS X.

iDisk

Your own storage space on Apple’s Internet
server. Share photos, movies, and other
files over the Internet. Access your files from
another Macintosh or PC.

HomePage

Build a personal Web site in three easy
steps. Create a photo album, publish
an iMovie, post your résumé, and more.
Anyone can view your site on the World
Wide Web.

iCards
Send an elegant iCard, just right for any

View Window Help

W) 11:23 AM

£

Macintosh HD

Internet

\ Displays Sound Network Startup Disk

hmﬂ Email ' Web ’ News\‘

Set up your iTools account

Enter your member name and password. This
infarmation is used to access iTools, including
your iDisk and your email account.

iTools Member Name: tclark3

Password: ssesesne

Need an account?

occasion. Choose a ready-made photo, or
Get the most out of the Internet with iTools. Click

create a personalized iCard using a photo | Sign Up and start using iTools today.
on your iDisk.

Email

Get your own Mac.com email address.
It’s easy and works with your favorite

email application.

To learn more about iTools:
= Go to www.apple.com/itools and click Help on the
iTools menu bar.

P> If you signed up for iTools when you first turned P> To sign up for a new iTools account, open
: on your computer, you already have an account. System Preferences and click Internet. Then
Go to www.apple.com/itools to get started. click Sign Up.

16
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Store pictures, movies, documents, and other files remotely.

Edit View B&8 Window Help S Crmmmmmmmmmm—m—
Computer : P> To access your files from another

Home : computer, log into your iTools account at
¢ www.apple.com/itools

@ Finder File ¢ ) 11:23 AM

Favorites

Applications ¢ > Anyone can access the files in your Public folder.

Recent Folders : ) .
Go to Folder... : P To find out how to use pictures and other

Back %[ files from your iDisk to create a personal Web
Connect to Server... : site, go to www.apple.com/itools and click the
: HomePage icon.

& telark3

i Computer Home Favorites Applications

About your iDisk Documents

) ]
Maovies Pictures Public

= (B0 Copy

¥ Copying “movie trailer.mov" to "Movies"

Software

item: "movie trailer.mov"
Copied: 4.4 M8 of 9.3 MB
Time remaining: About 5 seconds

Choose iDisk from
1. the Go menu.

Drag files to a folder on your iDisk
2 . tocopy them.
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@ Mail File Edit View Mailbox Message Format Window Help & ) 11:23 AM
806 No mailbox selected E“
- .=
. . ‘é“" = i . / w Ij Q™ [subject ¥ & Personal Mailboxes Macintosh HD
= S i - = [0utbox
Delete Reply Reply Al Forward  Compese  Mailbox  Get Mail Search Mailbox D
. || Drafts
D messages 7 Sent Messages

Ll # From Subject Date@ Time & | v & [Tools:tclark3@mail.ma
[EINBOX (Offline)

Follow these steps to create
and send a message.

P> To check for new messages, click Get Mail.
: To view a message, click its subject.

P> If you entered email information or got a

: Mac.com account when you first turned on your
computer, Mail is already set up. To set up a
new email account, choose Preferences from
the Mail menu, then click Accounts.

Click the Mail icon in the Dock
].. to open the Mail application.

18
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2.

@ Mail File Edit

View Mailbox

Message Format

Window Help

INBOX on iTools:tclark3@mail. mac.com

e / ﬂ" Q ¥ [Subject
rwar  Compase Mail Search Mailbax

0 messages — Connecting ta mail.mac.cam...

. # From

Subject Date & Time

To create a new email message,

click Compose.

e0e Mew Message

& o) 11:23 AM

¥ @ Personal Mailboxes
[&,0utbox
[ Drafts
F7Sent Messages

¥ # iTools:telark3@mail.ma
[INBOX (Offline)

Macintosh HD

(=]

v @ A0 N

Send Arttach Address Fonts Colors Save As Draft

To: jandoe@mac.com|

Cc

Subject: | Reunion

Dear Aunt Jan,

I'm really looking forward to seeing you and Uncle Johnny this weekend. It's
been too long. You won't believe how our little Andrew has grown!

We'll see you Saturday morning, with bells on.

Love,
Toni

Type the email address and a
subject. Then type your message

and click Send.

To learn more about Mail:

= Open Mail, then choose Mail Help from the
Help menu.

= Go to www.apple.com/macosx/applications/
mail.html
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Organize, plan, and create using AppleWorks.

Use AppleWorks for writing, drawing, making presentations, and more.

Layout capabilities
Add photos, tables,
charts, and sidebars.
Link text frames, layer
graphics, and wrap text.

Word processing
Write letters, create
brochures, make
greeting cards and
party invitations.

Presentation tool
Create an onscreen
slide presentation.
Add movies, art,
graphs, and charts.

Database

Keep records, save
addresses, make
inventories. Merge
mailing information with
the word processor to
send form letters.

20

Gourmet News

Winter 2000

Quarterly er for Food Lovers

Make Cooking Fun,
Fresh, and Fast

Duis autem vel eum iriure dolor in hererit
in vulputate velit esse molestie ¢

Gourmet News Presentation (DR)

Making a Perfect Brew
Ut wisi enim ad minim veniam, quis ol Tt
nostrud exerci tation ullamcorper ( A()t)l‘ulg LIS
suscipit loborts nis! ut aliquip ex ea « Chop the onions
‘commodo consequat. Duis autem

Vel eum irure dolor in hendrerit in * Slice the tomtatoes

Wouteto velt cece « Mix with peppers
Cooking * Add 1 cup of olive oil
Dinner for Six

Ut wisi enim minim
veniam, quis nostrud « Serve hot
exerci tationegm
per suscipit lobortis
Utwisi enim ad minim veniam, nostrud
‘exerci tation ullamcorper suscipit lob
facilisis at vero et accumsan.

* Suaté for 30 seconds

Customizable
Gourmet News templates

324 Sunview Way Choose from a wide
range of predesigned
documents and modify
them as needed.

L]

Contrals Spreadsheet
Eemem= Compute data easily
using over 100 built-in
functions, then use
formatting options to
make it stand out.

Intro

= Painting

Create art from scratch
or apply effects to
existing pictures

or scanned photos.

None 3
Ha®-

*x A B f@LoT

Extensive
clip art libraries

1

Nutitional Tips
Food pyramid Groups Examples | Nutrents Diet | Wb ink
@< Fats Candy None 0.1% | wwwiats.com
R Dary Chesse Calcium 19% | www.dairymeat.com
“ &meat afish &protein
* Fruit Apple Vitarmin 33% | wwwnitvegies.com
sveges | &camot &minerals
Al Grains Bread Fiber 41% | wewfibergrains.com

Choose from over
25,000 high-quality
clip art images.

eco Clippings

Search: | Food  Search )
¥ Search web Content

e B

e

appetizer romantic dinner
Ly
bowl of salad cup of tea
¥ Details i
A _search £ Animals / Fo... /| Household [ b
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To get started using AppleWorks:

P> Click the Web tab to download more templates
from the Internet.

o [

Macintosh HD

@ AppleWorks File (i1 Window © Help < W) 11:23 AM

Starting Points.

A0 @ 4 & =

Word Processing Spreadsheet Database Drawing Painting Presentation

Starting Points

% T | o =
I 7 Ol

#1 Dad Certificate Agenda All About Presen... Art Presentation Award Certificate Banner

To learn more about AppleWorks:

= See AppleWorks Help, available in the Help menu.

= Go to the AppleWorks Web site at
www.apple.com/appleworks

Click the icon in the Dock Click the type of document you want
1. to open AppleWorks. 2. to create, or click the Templates tab to
modify a ready-made document.

21
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é Finder File Edit View GCo Window Help

& o) 11:23 AM

Keep your iBook’s -
software up-to-date.  MAO R

Show Al Displays Sound Network Startup Disk

Use Software Update to mmEEom @
get the latest updates

Access

and drivers. ¢ = D A

CalorSync Displays  Energy Saver  Keyboard Mouse Sound

Internet & Network

® @ a u

Internet Network QuickTime Sharing

System

W n i
| = I ]
@ & @ § 1
Classic  Date & T| Software Speech  Startup Disk Users
Update

P To use Software Update, you must have an
Internet connection.

Click the icon in the Dock Click
1. to open System Preferences. 2 . Software Update.

22
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é Software Update Update Edit Window Help

Software Update

& ) 11:23 AM

« =& @ =

Show All © Displays Sound Metwork Startup Disk

Software Update checks for new and updated versions of your software based on
information about your computer and current software.

Update Software: &) Manually
® Automatically

Check for updates: = Weekly :

Checking oceurs only when yau have a netwark connection.

8086 Software Update

Software Update found the following new or updated
@ software for your computer.

Click the checkbox to select the software you want to install:

Status: Software Update was last run at 1:20 PM on 11/2/0L. D AirPort Software 2.0

Then click
Update Now.

install "Name Version  5ize

2.5MB
M Mac 0s X Update 1011 14.4M8

.Shmv'_aq e ( Update Now —

The 10.1.1 update delivers improvements for many USB and
FireWire devices, including support for additional digital cameras,
and overall improvements to CD and DVD burning. Enhancements
have been made to AFP, SMB, and WebDAV networking, as well as
improved support for printing. This update also delivers better
application compat v, including updates to the Finder and Mail
application. In addition, hardware accelerated videa mirroring has
been enabled for the new PowerBook G4.

Status: Net installed, restart required.

Updates to install: 1 o ( Install

4 Select the software you want to
. update and then click Install.

]

P> Click the name of a software item to learn
more about it.

P> You can schedule your computer to check
: automatically for software updates.

23
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@ Help Viewer File Edit Help e ¢ ) 11:23 AM

Learn more -

i‘\OW do | play an audio CD? e
. = @ Macintash HD

about using your B iy
thow do | play an audio CD? | A
computer.

. W :ev\;rﬂfleftu&n Wi 0% Page 1 of 2 abaut '{}ur}-zslﬁea}‘asudm €O" in Mac Help
Look in Mac Help for e S
. N N computer settings? Your Computer Using iTunes for Mac@5X ~ sssss
more information on using —
connected? computer
your computer. s F——

| Infa about
How do | print my
e aing
et compatibility and Changing the sound

updates Mare

Using Quicktime ta play movies
and music on your computer

F L T LT TR ELLL Y @ . About CD-R discs
P To browse the features of your computer, click — : 7 About CD-RW discs
© Go under “At a glance.” :

p Click Quick Clicks topics for answers to
frequently asked questions.

P To look at Help for other applications, click
the ? button.

Click the Finder icon Type a question
1. in the Dock. 5 and click Ask.

Then choose Mac Help from 4 Click an item in the list
2 . the Help menu. . of Help topics.

24
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These Apple Web sites will help you get the most out of your computer.

HotNews  Hardware Software PMadedMae" Education  Creatve  Smallsiz  Developer  Where to Buy

“Create Your Account—— View Current Order — Education —Federal— Worldwide —Helpy

00 ® Macintosh Products Guide =) 800 G The Apple Store (US) S 800 ® AnpleCare Service & Sapport [USA] =)
J « @ & = e o f = = e e ft A = = e
Back _orvard _Stop _ Refresh _Home __Autoril__Print__ Mai & sack_orward Refresh _Home __AutoFil_Print_Wai & Back _forwurd Stop _Refresh _Home __Autorill__print__ Mai —
@ [ (© v .apple.com/store. e.com /support
| “sore | iools | icards | quickrime | support | Macosx | [ @& Store Tools icards | QuickTime | Support | Mac 05X & Store Tools iCards

QuickTime upport Mac 05 X
Protection Plan  Downloads.

Macintosh Products Guide

Hardware
Software
Special Offers.
New This Week
Search

Hot Deals

Mac 05 X Products

Iy

X

]

a

Submit s Product

i

canon
Canon S800 C
N12200 USB

= 8

HPG Marketing Programs

0 Coldt
Bubbio.ot Photo Printor

PG Web Baes | Eeedback

Specifications  Knowledge Base  Discussions  Support Index_

E i (n (= le St
3 The new iPod. ] % = Apple Store |
\

Welcome
\ 1,000 songs in your pocket Signinor ereste vour
= o N = fn ereonal monunt
& — Sourn
Y °
4\ Al :
) il 3 o
o =
iMac Power Mac G4

® ® HE

"Top MacOS X Apps
e
D102 Uoaroe

- Offie o oirode
 Qusenzo0z

+ Print Explosion
» More

iBook PowerBook G4

AppleCare
Get online help!

by
a

ion up for an
Apple D today.

B \- - Shipping Delays
o

- What's New

- Knowledge Base
(Expert;
iscussions
nowledge

AppleCare

Service and Support

5

- Downloads

- Manuals

- AppleSpec

- Repair Status
- Mac OS Security

1

Multi-Lingual Support | &) © Support Site Index

Macintosh Products Guide
www.apple.com/guide

K

Mac

For great hardware and software products
for your Mac, check the Web site or look for
the Mac symbol. Also get contact and
support information for third-party software
manufacturers.

Apple Store
www.apple.com/store

Purchase the latest Apple and third-party hardware,
software, and accessories.

Apple Service and Support
www.apple.com/support

Product support, software updates, and
technical information.

P From these Web sites you can quickly link to
other Apple Web sites around the world.
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Advice and troubleshooting

If you don’t find the answer to your problem Switching between Mac OS X and Mac OS 9

on th€ fOHOWng pages: Your iBook is set to use Mac OS X. Most applications made for Mac OS 9
will work in the Mac OS X Classic environment. Just open the application
as you normally would. You can also start up your computer using

Mac OS 9.

To set your computer to use Mac 0OS 9:

Look in Mac Help.
= In Mac Help (see page 24), you can find a great deal of troubleshooting
advice, including information to help you solve problems with

= Connecting to the Internet )
m Choose System Preferences from the Apple (@) menu in Mac OS X.

m Click the Startup Disk icon to open the Startup Disk pane.

m Select the Mac OS 9 folder as your startup disk. If the icons are
dimmed, click the padlock icon and enter the password you chose
when you first set up Mac OS X.

m Click Restart.

»  Using software installation and restore discs
= Changing your computer’s settings

= Printing

= And more

m Click the Finder icon in the Dock, then choose Mac Help from the

Help menu. Type a question in the search window (for example,
type “How do I eject a diSC?”) and click Ask. To set your computer to use Mac 0OS X again:

= Choose Control Panels from the Apple (&) menu.
= Open the Startup Disk control panel.

m Click the triangle next to the hard disk that contains your operating
system folders.

= Select the Mac OS X System as your startup disk.
m Click Restart.
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If the computer won't respond:

Try to cancel what the computer is doing.

» Try to force problem applications to quit. Hold down the Option and
Command (88) keys, then press the Esc key. Select the application and
click Force Quit.

If that doesn’t work, restart the computer.

= Hold the Power button for several seconds. When the computer turns
off, press the Power button again to restart it.

= If that doesn’t work, hold down the Control and Command (38) keys
and then press the Power button.

= Ifthat doesn’t work, gently press the Reset (@) button by inserting the
end of a paper clip into the small hole above the audio/video port,
wait a few seconds, and then press the Power (D) button.

Then do this:

If the problem occurs frequently when you use a particular
application:

m  Check with the application’s manufacturer to see if it is compatible with
your computer.

= For support and contact information about the software that came
with your computer, go to www.apple.com/guide

If the problem occurs frequently:

= You may need to reinstall your system software. Choose Mac Help from
the Help menu and type “install system software” for more
information.

If you see a flashing question mark
during startup:

If the computer doesn’t start up after a delay, hold down the
Option key and restart your computer.

= When your computer starts up, click the hard disk icon, then click
the arrow.

Then do this:

After the computer starts up:

= Open System Preferences and click Startup Disk. Select a local
Mac OS X System folder.

If the problem occurs frequently:

= You may need to reinstall your system software. Choose Mac Help
from the Help menu and type “install system software” for more
information.
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If the computer won't turn on or start up:

First, make sure the power adapter is plugged into the
computer and into a functioning power outlet.

= Your battery may need to be recharged. Press the small button on the
battery. One to four lights glow indicating the battery’s level of charge.

If that doesn’t work or if you hear a strange sound during
startup:

= Ifyou recently installed additional memory, make sure that it is
correctly installed. Try removing the memory; if the computer starts up
normally, the memory is not compatible with your computer.

» If that doesn’t work, gently press the Reset (©) button by inserting the
end of a paper clip into the small hole above the audio/video port, wait
a few seconds, and then press the Power () button.

= See the service and support information that came with your iBook for
information on having your computer serviced.

If you can’t log into your computer:

Make sure you are typing your user name and password
correctly.

= Make sure you are using the same capitalization and punctuation that
you used originally. Check to see if the Caps Lock key has been
pressed.
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If that doesn’t work, reset your password.

= Insert the Mac OS X software install CD that came with your computer.
Restart your computer while holding down the C key. When the
Installer appears, choose Reset Password from the Installer menu and
follow the onscreen instructions.

If you can’t eject a CD or DVD or open the
optical drive tray:
Make sure the disc is not in use.

= Quit all applications that are using files on the disc.

= Then press the Media Eject (&) key at the top-right corner of
the keyboard.

» If that doesn’t work, hold down the function (fn) key and press
the Media Eject key.

» If that doesn't work, drag the disc’s icon to the Trash.

= If that doesn’t work, restart the computer, then hold down the mouse
button. To restart, choose Restart from the Apple (@) menu.

If the disc still won’t eject, eject it manually:

» Carefully insert the end of a straightened paper clip into the
emergency eject hole on the drive tray.
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Other problems:

If you have a problem with your Internet connection:
= Make sure the telephone line is connected to the modem (%) port
and the line is functioning properly.

If that doesn’t work, make sure your Internet settings are
configured correctly.

= Open the Internet Connect application in the Applications folder to
check your dialup or AirPort settings. Open System Preferences and
click Network to check your Internet settings.

= Ifyou're not sure of the correct information for your Internet settings,
contact your Internet service provider.

If you have a problem connecting other devices:

= Make sure that the device is properly connected. Try unplugging and
plugging in the device again.

= Check to see if the devbice has software that needs to be installed.

= Ifthat doesn't work, contact the device manufacturer.

If you have a problem with an application:

» For problems with software, contact the software manufacturer.

= For support and contact information about the software that came
with your computer, go to www.apple.com/guide

If you didn’t find the information you were looking for on this

page:

= Look in Mac Help. Click the Finder icon in the Dock, then choose
Mac Help from the Help menu. Type a question in the search window
(for example, type “How do I eject a disc?”) and click Ask.

If you suspect there may be a problem with your computer

hardware:

= You can use the Apple Hardware Test CD to help you determine if
there is a problem with one of your computer’s components, such as
the memory or processor.
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Install memory and an AirPort Card.

For detailed instructions, refer to Mac Help (see page 24).

Shut down your computer. Then Release the keyboard by sliding the If necessary, remove the metal clip

1. disconnect the power adapter and 2 two plastic tabs away from the display. 3 and pull the AirPort Card from the
phone cord. Turn the computer over Then lift the keyboard, flip it over, and adapter. The adapter is not used with
and remove the battery. lay it on the palm rests. the iBook.

P> If the keyboard doesn’t pop up, it may be

i locked. Locate the plastic tab next to the :
Num Lock key. Use a small flathead screwdriver —:
to turn the screw counter-clockwise 1/2 turn.
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Flip up the wire bracket and connect Slide the AirPort Card (with the Press the wire bracket down to secure
4. the end of the antenna to the AirPort S AirPort ID and barcode facing up) 6 the card. Then replace the keyboard

Card. Touch a metal surface inside the under the wire bracket and into and battery.

computer. the slot.
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Add additional memory.

Shut down your computer. Then Release the keyboard by sliding the If necessary, remove the
1. disconnect the power adapter and 2 . two plastic tabs away from the display. . AirPort Card.

phone cord. Turn the computer over Then lift the keyboard, flip it over, and

and remove the battery. lay it on the palm rests.

P> Your iBook has one expansion slot that accepts

: a standard PC-100 compliant, SO-DIMM
memory module (1.25-inch or shorter). For
more information on installing memory, look in
Mac Help, available in the Help menu.

P> If the keyboard doesn’t pop up, it may be :
locked. Locate the plastic tab next to the NUM 1 e |
Lock key. Use a small flathead screwdriver to i i P To prevent scratching, place a soft cloth
turn the screw counter-clockwise 1/2 turn. between the AirPort Card and the iBook case.
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———
4 Remove the two screws that secure Insert the RAM into the slot at an 6 Replace the keyboard and battery.
. the RAM shield, then carefully lift S angle and press down to lock it in .
it out. place. Replace the RAM shield and
AirPort Card (if necessary).

P For more information on the type of memory

to use with your computer, choose Mac Help USSRt es s TR T PR R PP O

from the Help menu. Then type “memory” and P> If you already have a memory card installed, P Never turn your computer on unless all of its

click Ask. remove it first. internal and external parts are in place.
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Work more comfortably

Use a light touch when typing or using the trackpad and keep your hands
Keyboard and tr aCkpad and fingers relaxed. Avoid rolling your thumbs under your palms.

When you use the keyboard and trackpad, your shoulders should be = >

relaxed. Your upper arm and forearm should form an angle that is e e Ewuw

slightly greater than a right angle, with your wrist and hand in roughly A ]
a straight line.
T T ET T LTI TTT
[T TTTTIIITT [T IITTTTITITT
g8 — — 7 Not this

Change hand positions often to avoid fatigue. Some computer users may
develop discomfort in their hands, wrists, or arms after intensive work
without breaks. If you begin to develop chronic pain or discomfort in your
hands, wrists, or arms, consult a qualified health specialist.
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Chair

An adjustable chair that provides firm, comfortable support is best. Adjust
the height of the chair so your thighs are horizontal and your feet flat on
the floor. The back of the chair should support your lower back (lumbar
region). Follow the manufacturer’s instructions for adjusting the backrest
to fit your body properly.

You may have to raise your chair so your forearms and hands are at the
proper angle to the keyboard. If this makes it impossible to rest your feet
flat on the floor, you can use a footrest with adjustable height and tilt to
make up for any gap between the floor and your feet. Or you can lower
the desktop to eliminate the need for a footrest. Another option is to use
a desk with a keyboard tray that’s lower than the regular work surface.

External mouse

If you use an external mouse, position the mouse at the same height as
your keyboard and within a comfortable reach.

Built-in display
Adjust the angle of the display to minimize glare and reflections from
overhead lights and windows.

You can adjust the brightness of the screen when you take the computer
from one work location to another; if the lighting in your work area
changes.

For more information

For additional ergonomic information, see the Apple ergonomic
Web site at www.apple.com/about/ergonomics
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Safety and cleaning

When setting up and using your computer, remember the following:

» Read all the installation instructions carefully before you plug your
computer into a wall socket.

= Keep these instructions handy for reference by you and others.

» Follow all instructions and warnings dealing with your system.

= Use only the Apple Portable Power Adapter that came with your
computer. Adapters for other electronic devices may look similar, but
they may damage your computer.

= Always leave space around your power adapter. Do not use this
equipment in a location where airflow around the power adapter is
confined, such as a bookcase.

m Always disconnect the power adapter, phone line, and any other cables
before opening the computer to perform procedures such as installing
memory.

= Never turn on your computer unless all of its internal and external
parts are in place. Operating the computer with missing parts can be
dangerous and damage your computer.
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Do not connect a digital telephone line to the modem, because the
wrong type of line could damage the modem.

When using your computer or when charging the battery, it is normal
for the bottom of the case to get warm. The bottom of the computer
case functions as a cooling surface that transfers heat from inside the
computer to the cooler air outside. The bottom of the case is raised
slightly to allow airflow that keeps the unit within normal operating
temperatures.

Keep your computer away from sources of liquids, such as drinks,
washbasins, bathtubs, shower stalls, and so on.

Protect your computer from dampness or wet weather, such as rain,
snow, and so on.

Warning Electrical equipment may be hazardous if misused.
Operation of this product, or similar products, must always

be supervised by an adult. Do not allow children access to the
interior of any electrical product and do not permit them to handle
any cables.

Never push objects of any kind into this product through the
openings in the case. Doing so may result in fire or a dangerous
electric shock.
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For your own safety and that of your equipment, always disconnect the
power plug (by pulling the plug, not the cord), disconnect the phone line,
and remove the battery if any of the following conditions exists:

= you want to remove any parts (leave the power cord disconnected as
long as the keyboard is open)

= the power cord or plug becomes frayed or otherwise damaged

= you spill something into the case

= your computer is exposed to rain or any other excess moisture

= your computer has been dropped or the case has been otherwise
damaged

= you suspect that your computer needs service or repair

= you want to clean the case (use only the recommended procedure)

Important The only way to disconnect power completely is to unplug
the power plug, disconnect the phone cord, and remove the battery.
Make sure at least one end of the power cord is within easy reach so that
you can unplug the computer when you need to.

Warning T0 avoid damage to your computer, Apple recommends
that only an Apple-certified technician install additional RAM or an
AirPort Card. Consult the service and support information that came
with your computer for instructions on how to contact an Apple-
authorized service provider or Apple for service. If you attempt to
install additional RAM or an AirPort Card yourself, any damage you
may cause to your equipment will not be covered by the limited
warranty on your computer. See an Apple-authorized dealer or
service provider for additional information about this or any other
warranty question.

Your iBook has a unique appearance and finish that may contain minor
imperfections, some of which may increase over time. Exposing your
iBook to extreme temperatures or humidity may cause this process to
accelerate. Proper care and handling, as described in this manual, will help
keep your iBook looking its best.

To clean the case, do the following:

1 Disconnect the power plug and phone cord and remove the battery.
(Pull the plug, not the cord.)

2 Wipe the surfaces lightly with a clean, soft cloth.
Warning Do not use any substance containing isopropyl alcohol. It

can damage the case. If necessary, use products made specifically for
cleaning computers.
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Where’s the fine print?

Communications, Telephone, and Modem
Regulation Information

For information on FCC regulations, radio and television interference, and
telephone and modem information related to this product, see the files in the
Communications Regulations folder, inside the Documents folder on your hard disk.

Laser Information

Warning Making adjustments or performing procedures other than those specified in
your equipment’s manual may result in hazardous radiation exposure.

Do not attempt to disassemble the cabinet containing the laser. The laser beam
used in this product is harmful to the eyes. The use of optical instruments, such as
magnifying lenses, with this product increases the potential hazard to your eyes.
For your safety, have this equipment serviced only by an Apple-authorized

service provider.

DANGER - Invisible I lation when open. AVOID DIRECT EXPOSURE TO BEA.
A CAUTION - mvisiste DIATION WHEN OPEN. AVOID EXPOSURE TO BEAN.

ATTENTION - RAYONNEMENT LASER INVISIELE EN CAS D'OUVERTURE. EXPOSITION DANGEREUSE AU FAISCEAU.
VORSICHT - UNSICHTEARE LASERSTRAHLUNG, WENN ABDECKUNG GEGFFNET. NICHT DEM STRAHL AUSSETZEN.
ATTENZIONE - RADIAZIONE LASER INVISIBILE IN CASO DI APERTURA. EVITARE L'ESPOSIZIONE AL FASCIO.
PRECAUCION - RADIACION LASER INVISIBLE CUANDO SE ABRE. EVITAR EXPONERSE AL RAYO.

VARO! - AVATTAESSA OLET ALTTINA NAKYMATTOMALLE LASERSATEILYLLE. ALA KATSO SATEESEEN.
VARNING! - OSYNLIG LASERSTRALNING NAR DENNA DEL AR GPPNAD. BETRAKTA EJ STRALEN.
ADVARSEL!- USYNLIG LASER STRALING, NAR DENNE ER ABEN. UNDGA BESTRALING.
ADVARSEL - USYNLIG LASERSTRALING NAR DEKSEL APNES. UNNGA EKSPONERING FOR STRALEN.
z8 - 13, = LT

CLASS 1 LASER PRODUCT
LASER KLASSE 1

APPAREIL_ A RAYONNEMENT
LASER DE CLASSE 1

Service Warning Label

Apple Portable Power Adapter

The Apple Portable Power Adapter that comes with your computer is a high-voltage
component and should not be opened for any reason, even when the computer is turned
off. If your computer needs service, contact your Apple-authorized dealer or service
provider.
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Battery

Warning Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to your local environmental guidelines. Do not puncture or
incinerate.

High-Risk Activities Warning

This computer system is not intended for use in the operation of nuclear facilities, aircraft
navigation or communications systems, or air traffic control machines, or for any other
uses where the failure of the computer system could lead to death, personal injury, or
severe environmental damage.

iPod Information

The Apple iPod pictured on page 11 of this manual is not included with this product. For
more information on iPod, go to www.apple.com/ipod

ENERGY STAR®

As an ENERGY STAR® partner, Apple Computer has determined that standard
configurations of this product meet the ENERGY STAR® guidelines for energy efficiency.
The United States Environmental Protection Agency’s ENERGY STAR® program is a
partnership with office product equipment manufacturers to promote energy-efficiency.
Reducing energy consumption of office products saves money and reduces pollution by
eliminating wasted energy.

This information applies to the standard configurations of the computer using the
Mac OS X operating system.

Every effort has been made lo ensure that the information in this manual is accurate.
Apple is not responsible for printing or clerical errors.

Download from Www.Somanuals.com. All Manuals Search And Download.



www.apple.com

© 2002 Apple Computer, Inc. All rights reserved.
AirPort, Apple, the Apple logo, AppleWorks, FireWire, the FireWire logo, iBook, Mac, the Mac logo, Macintosh, QuickTime, and Sherlock are trademarks of Apple Computer, Inc., registered in the U.S. and other countries.
Finder, iMovie, iPod, and iTunes are trademarks of Apple Computer, Inc. ENERGY STAR® is a U.S. registered trademark. Digital imagery copyright 1998 PhotoDisc, Inc.
034-2095-A  Printed in Taiwan

Download from Www.Somanuals.com. All Manuals Search And Download.



Free Manuals Download Website
http://myh66.com
http://usermanuals.us

http://www.somanuals.com

http://www.4manuals.cc

http://www.manual-lib.com

http://www.404manual.com

http://www.luxmanual.com

http://aubethermostatmanual.com

Golf course search by state

http://golfingnear.com

Email search by domain

http://emailbydomain.com

Auto manuals search

http://auto.somanuals.com

TV manuals search

http://tv.somanuals.com



http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/

